
The Add submenu

The Add submenu contains the following commands:

Chat File

Adds a new public chat to the current conference.

Gateway Settings

Displays the New Gateway form, which you use to create a new gateway. Before you select this option, 
you either:

Open the Gateway folder.

Open the Multi-Vol Conference folder, and select the volume on which you want the gateway's files to 
be stored.

Privilege Group

Displays the New Priv Group form, which you use to create a new privilege group.

Mail List

Displays the New Mail List form, which you use to create a new mailing list.



Addressing a message

When you create a new message, you fill in the To and Cc fields with the names of the people or 
conferences who are to receive the message. Follow these steps:

1. Click in the To field, enter the name of the user or conference you want to send to, and press Enter. 
You don’t have to worry about capitalization, and you don’t even have to enter the whole name, just 
enough to enable FirstClass to identify the recipient. 

To: joan smi
Cc:

FirstClass searches its Directory for the closest match and places it back into the field.

To: Joan Smith
Cc:

If the name matches more than one user, a window containing all matching names appears. For 
instance, if you entered the following,

To: Joan Smith
Cc: roy

You might see the following window:

Here the matches include all users and conferences that contain a name or a word beginning with the 
characters "roy". 

2. Highlight the name you want and click Select. (You can select multiple names by holding down the 
Shift key while you click on them.) 

FirstClass places the selected names in the envelope:

To: Joan Smith
Cc: Roy W. Allen

Gillian Royce



The Admin menu

If you are logged in as the FirstClass Administrator, the FirstClass menu bar contains the Admin menu. 
This menu contains the following commands:

System Profile

Displays the System Profile form, which contains configuration information for your server.

List Users

Displays the List Users form, which you can use to list all the users, conferences, gateways, routes, and 
so on, defined in the FirstClass Directory.

Add

Displays the Add submenu. You can use this menu to add public chats, gateways, privilege groups, and 
mail lists.

New Stationery

Displays the New Stationery submenu. You can use this menu to add stationery to a conference.

Add New User

Displays a blank User Information form, which you can use to add a new user.

Delete User

Displays the Delete User form. To delete a user, enter the user's id in this form.

Change User

Displays the Change User form, which prompts for the user id of the user to be changed.

Give Alias

Displays the Give Alias form, which allows you to give a user a subscription to the selected conference.

Open User Desktop

Displays the Open User Desktop form. Specify the user id of the user whose desktop you want to view.

Broadcast

Displays the Broadcast form, which you can use to enter a message and send it to all logged-in users.

Control

Displays the Control submenu, which you can use to manage the server (start a trash collection, shut 
down the server, log off all users, and so on).

System Monitor

Displays the System Monitor, which shows all users logged into the server and what they are doing.



Attaching files to messages

To send a file to another user or a conference, follow these steps:

1. Create a new message as usual. 

2. Choose File ® Attach File. FirstClass prompts you to select the file that you want to attach. 

3. Select the file and click OK to transfer the file from your computer to the server. 

The time required for the transfer will vary depending on the size of the file and the speed of your 
connection. While the file is being transferred, the File Transfer Progress window is displayed. You 
can continue to use all of the features of FirstClass while the file transfer is in progress.

When the transfer completes, the attachment is added to the list in the envelope of the message. You 
can attach as many files as you wish. If you make a mistake, you can delete an attachment by 
selecting it and pressing Delete.



If you are sending attachments that will be downloaded by users logged on with modems, or if you are 
using a modem, you should consider using a compression utility. Compressing files allow them to be sent 
faster, thereby reducing the duration of your phone calls. They also use up less storage space on the 
server. 

If a file is only partially uploaded, it will have a partial transfer icon         To continue from the point at 
which the transfer stopped, restart the transfer. When prompted "Replace existing file?" click Yes. Only 
the remaining data will be transferred.



Attachment icon

An icon in the message summary that indicates the message contains one or more attached files: 

See Transferring files for details.



Attachments

Files that are associated with messages and that can be transferred from the server to a local computer.



Cancel

The button that terminates the login process, if you have clicked Login. If you have not, it closes the login 
window.



Cancel

The button that cancels the search.



Chat transcript

The pane that contains the text of the chat messages. It also contains information about each person who 
enters and leaves the chat. Choose File ® Save as Text to save a copy of the transcript.



Chatting

The Chat feature allows you to have real-time conversations with multiple users. To start a private chat, 
choose Service ® Private Chat. To enter a public chat, double-click on the chat icon.

 To find out more about an area on the Chat form, click on the area.



Client

The application with which users connect to the server and access its services.



Conference and mailbox shortcuts

Alt + Enter

Displays information about the selected message or file.

F2

Opens the next message in the current thread.

Control + F2

Opens the previous message in the current thread.

Control + U

Opens the next unread item.

Control + F

Finds specified text in messages or documents.

Control + G

Finds the next instance of the specified text.

Page Up

Moves up through a message screen by screen.

Page Down

Moves down through a message screen by screen.

Control + N

Creates a new message in your mailbox.

Control + A

Selects all items in the current window.

Control + O

Opens the selected items.

Control + D

Deletes the selected items.



The Conference menu

The Conference menu contains the following commands:

Open Unread

Opens the next unread item in the current window.

Next in Thread

Opens the next message in the current thread.

New Conference

Creates a new conference. If you do not have the privileges necessary for creating conferences, this 
option is dimmed.

New Folder

Creates a new folder in the current window.

Make Alias

Makes an alias of the currently selected conference and place the alias on your desktop.

Permissions

Displays the Permissions Form for the currently open or selected conference. If you do not have 
permission to view conference information for this conference, this option is dimmed.

Approve

Approves the selected or current message. If you do not have the approver permission for this 
conference, this option is dimmed.

About Conference

Displays information about the selected or current conference. If you do not have permission to view the 
conference information for this conference, this option is dimmed.



Conferences

A conference is similar to a folder, in that it can contain messages, files, folders and subconferences. In 
addition, for conferences, FirstClass keeps track of the items you have not read. Unread items are 
marked with an Unread flag.



Conferences folder

The conferences folder contains all of the publicly-accessible conferences set up by your FirstClass 
Administrator.



Configuring the Settings Document

Before you use a Settings Document for the first time, you should ensure that it is configured correctly. To 
configure the Settings Document, follow these steps:

1. Double-click on the Settings Document. 

2. When the Login Form appears, click Setup.

The title of the Settings Document contains the name of the settings file you are using. To find out 
more about the fields or buttons on this form, click on them.

3. Enter information into the following fields.

Connect Via

Select the method you will use to connect to the server. If you will be connecting across an IPX 
network, select IPX.FCP. If you will be connecting across a TCP/IP network select TCP-IP.FCP. If you 
will be using a modem to connect, choose MODEM.FCP.

Setup button

Click this button to configure the connection. You will not normally need to configure an IPX 
connection, but you might need to configure a modem or TCP/IP connection. Note: You only need to 
configure the connection once. All Settings Documents that use the same type of connection use the 
same configuration for that connection. For a modem connection, you would only need to change the 
configuration if you installed a different modem, or moved your modem to a different COM port.

User ID

Enter your user id here to have it automatically stored in the Settings Document.

Password

You can enter your password here to have it automatically stored in the Settings Document. Note: If 
other people have access to your computer, you may prefer, for security reasons, not to save your 



User ID or Password. If you choose not to save this information, you can simply type them into the 
box on the Login Form every time you open the Settings Document.

Logon Automatically

Check this box if you want FirstClass to log into the server automatically as soon as the Settings 
Document is opened. Note: You can disable the automatic logon by holding down the Control key 
when you open a Settings Document.

Retry, Retry Delay

If you connect to the server by modem and if you receive frequent busy signals, you can configure 
FirstClass to retry automatically. The Retry box controls the number of times FirstClass will retry; the 
Retry Delay box controls the delay between retries. (Not required for network connections.)

Server, Network

For IPX connections, enter the server name in the Server field. For TCP/IP connections, enter the 
server address in the Server field. (Not required for modem connections.)

Phone Number

For modem connections, enter the server phone number in this box. If you are connected to an office 
phone system, you may have to enter a "9" (or other special dialing prefix) followed by a comma to 
dial out correctly. (Not required for network connections.)

4. When you are finished, click one of the following buttons:

Save button

To close the form and save all of the changes that you have made into the current Settings 
Document.

Cancel button

To close the form without saving any of the changes.



Configuring the modem connection

Before you start using FirstClass with a modem, you must set up FirstClass and your computer so that 
they work together correctly with your modem. After you configure your modem connection, you should 
not need to change it, unless you install a different modem, or move the modem to a different COM port. 
You will use the same modem configuration for all your Settings Documents. Note: Your modem 
configuration is stored in a file called MODEM.FCP.

To configure your modem, follow these steps:

1. Double-click on a Settings Document that uses the modem connection.

2. Make sure that the Connect via field is set to MODEM.FCP.

3. Click Setup. The MODEM.FCP form appears:

To find out more about the fields or buttons on this form, click on them.

4. Fill in the following fields:

Modem

Select the type of modem you are using. If your modem does not appear in the list, select a 
"compatible" modem with the same speed as your modem. For example, if your modem is a V.32bis 
modem, select Hayes Compatible 14400.

Port

Select the COM port to which your modem is connected (for example, COM1).

Phone

Select the type of phone line that you have (Pulse if you have dial phones, Tone if you have Touch 
Tone phones).

Speaker



Choose whether you want the modem speaker turned on or off during dialing and negotiation.

Cable Options

If you have an internal modem or a standard (hardware handshaking) modem cable, do not change 
these fields. When you select a modem, they are automatically set to the value appropriate for the 
modem.

Speed Options

When you select a modem, the Auto Speed and Baud Rate fields are automatically set to the value 
appropriate for the modem. You should not change these fields.

5. When you are finished, click one of the following buttons:

Save

To save your modem configuration.

Cancel

To close the form without saving any of the changes.

Next time you make a modem connection, FirstClass automatically uses these settings. 



Connecting to FirstClass with a modem

If you are using a modem connection, the following process occurs after you enter your user id and 
password and click Login:

1. FirstClass sends a Reset string to the modem, and waits for an "OK" response.

The status line displays "Resetting modem" followed by the reset command sent to the modem. 

2. When FirstClass receives the "OK" response, it sends the Initialization string to the modem. Note: 
Because each type of modem requires a different Initialization string it is important that you have 
selected the correct modem type when you configure your modem.

The status line displays "Setting up modem" followed by the Initialization string sent to the modem. 

3. Once the modem has been initialized, FirstClass sends any optional commands that are set up in the 
modem configuration (such as speaker volume, hardware handshaking, and carrier detection).

The status line displays "Sending modem options" followed by the optional commands sent to the 
modem.

4. FirstClass then tells the modem to dial the phone number stored in the Settings Document.

The status line displays "Dialing the number" followed by the dialing command sent to the modem. 
Make sure that the phone number is correct.

5. While the modem is dialing, FirstClass waits from a "CONNECT" response from the modem.

The status line displays "Waiting for connection" followed by the dialing command sent to the modem.

6. One of the following outcomes is possible:

The server answers the call and the two modems connect. 

The status line displays the messages "Negotiating connection" and then "Connected." At this 
point the user id and password are sent to the server. If your user id and password are correct, 
your FirstClass desktop appears.

If the server modems are all busy, the modem reports "BUSY" and the status line displays "Line is 
busy". The login fails.

If the modems are unable to connect for any reason, your modem reports "NO CARRIER" and 
the login fails. 

If the connection fails for any other reason, contact your FirstClass Administrator or Technical 
Support.

Note: If any step fails, the entire login stops.

Configuring the modem connection
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Control submenu

The Control submenu contains the following commands:

Trash Collection

Starts the Trash Collection process, which deletes expired messages.

Fast Shutdown

Logs off all users without warning and shuts down the server immediately.

Polite Shutdown

Sends a broadcast message to all users, notifying them that the server is shutting down, and asking them 
to log off. When all users have logged off, the server shuts down. Note: Once Polite Shutdown has been 
initiated, it cannot be stopped. However, you can perform a fast shutdown while a polite shutdown is in 
progress.

Restart

Logs off all users and restarts the FirstClass server.

Logoff All Users

Logs off all users except the FirstClass Administrator.

Logoff Selected Users

Logs off the users selected in the Who's Online list.

Reset Server Modems

Sends the Reset string to all modems that are not currently in use. Modems should be reset after they are 
turned off and on.
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Date

The date that the message was sent. If a message is unsent, this line will read "Unsent."



Date & Time

The date and time that the message was delivered.



The desktop

Once you are connected to the server, your FirstClass desktop appears on the screen. The desktop is 
your starting point for using FirstClass. To open any item on the desktop, double-click on it. To close the 
desktop, either exit the FirstClass Client application or choose Service ® Disconnect.

.

In this example, the desktop has been customized with a background graphic. 



Downloading

Copying files from a server to the client.



The Edit menu

The Edit menu contains the following commands:

Undo

Undoes the last action in the current window. Choose this option again to undo the previous action in the 
current window.

Redo

Redoes the last action you undid.

Cut

Deletes the selected information and place it on the clipboard.

Copy

Places the selected information on the clipboard.

Paste

Inserts the information on the clipboard into the current window.

Clear

Deletes the selected information.

Select All

Selects everything in the current window.

Font

Changes the font for the selected text.

Size

Changes the font size for the selected text.

Style

Changes the font style (that is, italic, bold, and so on) for the selected text.

Color

Changes the color of the selected text.

Preferences

Displays your personal Preferences form.

Résumé

Displays your résumé. 



Editing shortcuts

Control + A

Selects all the text in the current field or pane.

Control + C, Control + Insert

Copies selected text onto the clipboard.

Control + V, Shift + Insert

Inserts the contents of the clipboard after the cursor.

Control + X, Shift + Delete

Deletes the selected text and copies it to the clipboard.

Delete

Deletes the highlighted text.



Envelope

The part of the message that contains addressing information, the list of attachments, the postmark, and 
the date and time the message was sent. If the message is a form, the envelope contains the additional 
form information—in this example, a picture preview. To view the entire picture, double-click on it.



The file list window

The file list window appears when you open either a conference, a folder, or your mailbox.    The window 
has two panes: an upper pane, which contains subconferences or folders, and a lower pane, which 
contains documents, files, and messages.

For each pane, you can choose whether to display items as icons, or as a sorted list. In the following 
example, the view of the top pane is by icon, and the view of the bottom pane is in reverse order by date. 
To change the view for a pane, use the View menu.

In a sorted list, each item is displayed on a single line. 

To open an item, double-click on it. An open item appears dimmed in the list. In the example, the third 
item is open. 

To select an item, click on it. In the example, the second message has been selected.

FirstClass also supports external folders that are links to CD-ROMs and hard disks.



The File menu

The File menu contains the following conmands:

New Settings

Creates a new Settings Document. This command is available only if you are not logged into a FirstClass 
system.

Open

Opens the selected item. Note: You can also double-click on an item to select and open it in a single 
step.

Save

Saves the current item on your hard disk. You don't need to save messages; they are automatically saved 
on the FirstClass server.

Save as Text

Saves the contents of the current window as an ASCII text file.

Print

Prints the current window.

Attach File/Upload

Transfers a file from your computer to the FirstClass server. If the current window is a message, this 
menu item will be Attach File. If the current window is a conference or folder, the menu item will be 
Upload. If you do not have file transfer privileges, this menu item is dimmed.

Save Attachment/Download

Transfers a file from the FirstClass server to your computer. If the current window is a message, this 
menu item will be Save Attachment. If the current window is a conference or folder, the menu item will be 
Download. If you do not have file transfer privileges, this menu item is dimmed.

Delete

Deletes the current item or any selected items. This menu item is dimmed if you don't have delete 
permissions for the current conference.

Get Info

Displays additional information about the current item or any selected items.

Search

Searches the current window for a text string. This option is dimmed if you do not have search privileges.

Search Next

Finds the next item matching the current search specifications.

Exit

Exits from the FirstClass application. If you are connected by modem, FirstClass asks you to confirm that 
you indeed want to quit.



Fill bar

A status indicator at the top of the file list window. It indicates that titles are being added to the list. When 
the bar reaches the right edge of the window and disappears, the list is complete.



Folders

A container used to store and organize messages and files.



Folders & Conferences

The upper pane of the file list window, which can contain folders and conferences. In this example, the 
window view is by icon. To change the view, use the View menu.



From 

The name of the sender. You cannot change this field.



Gateway

Software that works in conjunction with your FirstClass server and allows your server to exchange 
information with other communication systems.



Help folder

A folder containing helpful instructions for using your FirstClass system.



Input box

Type your chat messages here. To send the message, press Enter.



Introduction

FirstClass® is an easy-to-use communication system for Windows. With FirstClass you can send and 
receive electronic mail, share files, use electronic conferencing to exchange ideas, and participate in on-
line chats. Because FirstClass uses the familiar Windows graphical user interface, you will find it fast, 
intuitive, and easy to learn. 

FirstClass consists of two parts: the client (you) and a server. 

To use FirstClass, you need both the FirstClass Client application and a Settings Document for the 
system to which you want to connect. The Settings Document must be configured to connect to the 
FirstClass system. Your FirstClass Administrator might provide you with a configured Settings Document, 
or you might need to configure it yourself.

You also need either a network or modem connection to the server. If you are connecting to the server by 
modem, you must ensure that the modem connection is configured correctly.

Before you can actually use FirstClass, you must log into the server.

Configuring the Settings Document

Configuring the modem connection

Logging in to FirstClass



Invite button

To invite other users into the chat, click Invite. Select the names of the users you wish to invite and click 
Select.



Keyboard shortcuts

FirstClass supports the standard keyboard method for choosing from Windows menus. You can enter 
some commands in more than one way.

Message shortcuts

Editing shortcuts

Conference and mailbox shortcuts

Other shortcuts



Logging in to FirstClass

Once you have customized the Settings Document and (if you are using a modem) configured your 
modem, you can log into FirstClass. To do so, double-click on the Settings Document for the system to 
which you want to connect.

FirstClass displays the Login form for the system you’ve chosen. A typical Login form is shown below.

To find out more about an area on the form, click on it.
If the login is successful, the desktop is displayed.

Configuring the Settings Document
Configuring the modem connection
Connecting to FirstClass with a modem



Login button

To begin the login process, enter your user id and your password, and click Login.



Mailbox

Your mailbox contains all of the mail that you have sent and received. To open your mailbox double-click 
on the icon.



Mailing list

A group of users to whom you often send the same messages.



Maximize & Minimize buttons

Click on the maximize button at the right to expand the window and show all the items that will fit on the 
screen. Click on the minimize button on the left to shrink the window back to its original size.



Message body

This is the body of the message. To enter text in an unsent message, click in this area and start typing. 
You can use the Copy, Cut, and Paste options on the Edit menu to copy and move text within the 
message, or to copy text from another message or document into this message. You can also use the 
Font, Size, Style, and Color options on the Edit menu to change the font, font size, font style (italic, bold, 
and so on), and font color. Note: You cannot change text in the body of a sent message.



Message icon

The standard message icon. A message received through a gateway has an icon like this:    



Message icon

The standard message icon. If the message has been sent through a gateway, it has a gateway message 

icon that looks like this            To use another icon, choose File ® Get Info and double-click on the 
icon in the info window.



The Message menu

The message menu contains the following commands:

New Message

Creates a new message. If you choose this menu item in a conference for which you have send 
permissions, the message is automatically addressed to the conference.

New Document

Creates a new document in the current conference or folder.

New Form

Displays a submenu from which you can choose an alternative form for the message you are sending. If 
you choose this menu item in a conference for which you have send permissions, the message is 
automatically addressed to the conference.

Reply

Creates a reply to the open or selected message. By default, replies to messages in your mailbox are 
addressed to all recipients, while replies to messages in conferences are addressed to the conference 
only. To select different recipients for the reply, use the Reply Special command.

Reply Special

The Reply Special submenu contains the following options:

Reply All—Addresses the reply to all recipients of the original message.

Reply Sender—Addresses the reply only to the sender of the original message.

Reply Conference—Addresses the reply only to the conferences in the address of the original 
message.

Forward

Creates a message that is an exact copy of the open or selected message. You can address and send 
this new message. If you do not have the Forward privilege, this menu item is dimmed.

Send

Sends the current message. This option is dimmed if the current item is not a message or if the current 
message has already been sent.

Unsend

Retracts the open or selected message. If you do not have the Unsend privilege, this menu item will be 
dimmed.

History

Displays the history form for the open or selected message. If you do not have the View History privilege, 
this menu item is dimmed.

Unread

Toggles the Unread Flag on the open message or the selected messages in the current window. To toggle 
the Unread Flag, you must have the Make Read privilege.



Show BCC

Displays the Bcc field on a message you are sending, so that you can send blind courtesy copies. 
Recipients specified in the To and Cc fields will not be able to see who received Bccs.

Priority

Sets the priority of the open message. The priority is used to control the behavior of mail sent through 
gateways as well as the display of the message in the recipient’s mailbox. Available priorities include:

Normal—The standard setting.

Urgent—Displays the message subject in bold and invokes special gateway handling.

Bulk—Used for some gateways. Consult your administrator to find out if this option is available to you.

Sensitivity

Sets the sensitivity of the open message. This setting has no effect on the way the message is handled. It 
is provided as information for the recipient, and might be used by third-party gateways. Available 
sensitivities include:

Normal—The standard setting.

Personal.

Private.

Company.

Receipt

Turns on automatic receipt generation. Receipt options include:

On Read—Generates a receipt when the recipient reads the message.

On Delivery—Generates a receipt when the message is delivered to the recipient (This is useful when 
the recipient is on another server.)

On Route—Generates a receipt at each stage of the delivery of multi-hop mail. This is useful for 
detecting problems in multi-server mail systems.

Suppress NDN—Prevents the generation of Non-Deliverable Notices (NDNs).



Message shortcuts

Control + N

Creates a new message in your mailbox.

Control + R

Replies to a message.

Control + Up Arrow, Control + Down Arrow, F6

Moves between the upper and lower pane in a message window.

Control + E

Sends the current message.

Control + T

Attaches a file to a message

Control + H

Displays the history of the current message.

Alt + Enter

Displays information about messages and files.

Control + F

Finds specified text within a message.

Control + G 

Finds the next instance of the specified text.

Page Up

Moves forward through the current message one screen at a time.

Page Down

Moves backward through the current message one screen at a time.



The message window

When you open any message in a file list, the message appears in a message window. (A message 
window also appears when you create a new message.) From the message window, you can perform any 
action available from the file list (like reply to the message, save the message as a text file, or delete the 
message), or you can use the standard Windows editing commands. 

If the message is part of a thread you can use the Previous in Thread and Next in Thread buttons on the 
palette to browse through the thread. 

If you resize the window, subsequent messages appear in the resized window.



New stationery submenu

This menu contains all the stationery forms that you can add to a conference. Make sure you are in the 
correct conference before selecting a form.



News

A special conference used for general announcements. 



Number of files

The total number of files in the list. The number of files displayed might be less than this total if you’ve 
checked the Display Unread Only preference. 



Number of folders

The total number of folders or conferences, or both, in the list. Folders and conferences always appear 
above the split bar.



Other shortcuts

Control + L

Searches the FirstClass Directory.

Control + P

Prints the active window.

Control + W

Closes the active window.

Control + K

Disconnects from the FirstClass server.

Alt + F4

Exit the FirstClass client application.

Shift + F1

Displays the table of contents for the online help system.



Palette

FirstClass has a floating palette that provides one-step access to common functions. To display the 
palette, choose Window ® Palette. To display a horizontal palette, hold down the Control key when you 
select Palette.



Participants list

The list of users participating in the chat. Double-click on a user's name to display the user's résumé.



Permissions

Your permissions determine the level of access you have to a conference. The following access levels are 
available:

Disallowed: Users cannot open the conference.

Summary: Users can open the conference and view the list of messages, but they cannot open 
messages.

Browser: Users can read messages.

Contributor: Users can read messages, send messages to the conference, delete messages they have 
sent, and view the Conference Permissions form.

Approver: (Used in moderated conferences) Users can open unapproved messages and approve them.

Moderator: Users can approve messages, delete any messages in the conference, and create 
subfolders.

Creator: Users can approve messages, delete messages, create subfolders, move and resize windows, 
and create subconferences.

Controller: Users have all privileges, including the right to edit the Permissions Form and edit messages 
sent by other users.

Custom: Users have selected privileges, as assigned by the Administrator.



Postmark

After you send a message, the system places a postmark in the upper right-hand corner.



Preferences

You can customize your preferences, which control the way your e-mail and chat functions work. To view 
or change your preferences, choose Edit ® Preferences. The Preferences form appears. It contains the 
following fields.

Note: To change your preferences, you must have been assigned the necessary privileges by your 
FirstClass Administrator.

Mailbox preferences
Show items in conferences in reverse order: Reverses the sort order for objects in conferences. (By 
default, objects in conferences are listed in chronological order.) You can change the sort order for 
individual conferences by choosing View ® Reverse Sort. However, if you do not have the permission    to 
move and resize windows for a conference, the new view is not saved. Therefore, you might choose this 
option.

Show only unread items in conferences and mailbox: Displays only those items you have not yet 
seen (that is, items with an “Unread flag” on). This option is useful for large conferences, especially if you 
are connecting by modem. Note: Conferences with no unread messages will appear to be empty.

Reply Preference: You can choose how the Reply option will work. You have the following choices:

Automatic: Performs a “Reply Conference” if you are within a conference, otherwise performs a 
“Reply All”.

Reply All: Replies to the sender and all other names in the original To and Cc lists.

Reply Sender: Replies only to the sender of the original message.

Chat preferences
Don’t accept invitations: Prevents other users from interrupting you with chat invitations. Your name 
displays in italics in the FirstClass Directory, and when users try to invite you to chat, the invitation is 
automatically declined.

Sounds during chat and invite: Turns chat sounds on and off.

Mail rules
Forward My Mail: Automatically forwards all received mail to the list of people specified in the To field.

Reply Automatically: Sends a reply each time a message is addressed to your mailbox. Enter the text of 
the reply message in the text box. This option is useful if you go on vacation.

Note: To use the Automatic Forwarding and Automatic Reply options, you must have been granted the 
necessary privileges by your Administrator.



Previewing attachments

You can preview pictures, sounds, or text files, before saving them. To do so, holding down the Control 
key and double-click on the attachment.



Private chat

An impromptu chat initiated by a user.



Privilege Group

One or more users who require the same privileges or permissions, or access to the same conferences.



Privileges

Your FirstClass Administrator assigns you privileges, which determine the features to which you have 
access. Your privileges might give you the ability to:

Send and receive private e-mail

Access public conferences

Forward messages

Transfer files to and from the server

Search messages and documents

Unsend messages

Mark messages urgent

Request receipt notification for messages

Set the expiry date on messages

Mark messages as Read or Unread

Set up auto-forwarding or auto-reply

Create address books

Participate in chats

Create conferences

View résumés or user information

Edit user information

Change your preferences

View and send mail to unlisted users



Public chat

A chat created by the FirstClass Administrator, and usually dedicated to a specific topic.



Saving attachments

If a message has attached files, the attachments are listed in the envelope after the To and Cc lists.

To upload an attachment, double-click on the attachment. FirstClass prompts you to select the location on 
your computer in which you want to save the file.

Once you have selected the location, click OK. The system transfers the file from the FirstClass server to 
your computer. Note: The time required for the transfer varies depending on the size of the file and the 
speed of your connection.

As the system transfers the file, the File Transfer Progress window appears. You can continue to use all 
of the features of FirstClass while a file transfer is in progress. To cancel a transfer, close the progress 
window.



Note: If you cancel a file transfer before it is finished, you can restart the transfer by downloading to the 
same location on your computer. When prompted "Replace existing file?" click on the "Yes" button. Only 
the remaining data will be transferred.



Scroll bar

The scroll bar functions like a typical Windows scroll bar. You can click in the gray area to move up or 
down by one screen.



Scroll lock

Check this box to stop the text in the chat transcript window from scrolling.



Search

The button that begins the search process.



Search To/CC Lists

Check this box to search for the specified text in all names in the To and Cc lists.



Search Content

Check this box to search for the specified text in the body of all messages and text files.



Search Folders & Conferences

Check this box to search for the specified text in all the folders, conferences, and items in the current 
window.



Search For

Enter the text for which you are searching.



Search From

Check this box to search for the specified text in the names in the From list.



Search Attachment Names

Check this box to search for the specified text in the names of all attachments.



Search Subjects

Check this box to search for the specified text in all subjects and file names.



Searching

You can use the Search feature to search the entire FirstClass system for occurrences of specified words. 
To use the Search feature, follow these steps:

1. Open the folder or conference that you want to search.

2. Choose File ® Search.

A Search window appears. 

3. Enter the text you wish to search for in the Search For box and check the appropriate option boxes. 

4. Click Search to start searching.

A new window opens and displays a list of matching items. 

5. Double-click on an item in the list to open it.

You can use the Next Message and Previous Message buttons on the palette to scroll through the 
items on the list, and the Find Next button to highlight the next occurrence of the word within a 
message.

Note: To find out where the item is located, select it and choose File ® Get Info.

To find out more about a field on this form, click on it.



Send

Once you have entered your message click Send to add it to the conversation.



Sender

The name of the person who sent the message.



Server

An application that runs on a separate, usually dedicated, computer. The FirstClass server controls who 
can connect to the FirstClass system, what they can do when they are connected, and what information 
they can see.



The Service menu

The Service menu contains the following commands:

Connect/Disconnect

If you are not connected to a FirstClass server, this option initiates a connection using the connection 
method you have chosen. If you are already connected, this option disconnects you from the FirstClass 
server.

Setup

Displays the Settings form for the Settings Document you have open.

Connection Setup

Displays a submenu of available connection types. Choose the connection type for which you want to 
display the Connection Setup form.

Directory

Opens a window that allows you to display names in the FirstClass Directory.

Who's Online

Displays a list of all users logged on to the FirstClass Server.

Private Chat

Initiates a private chat with one or more users. Once the Chat Window is open, you can invite other users 
into the chat by clicking Invite.

Password

Changes your password.



The Session Status window

To display the floating Session Status window choose Window ® Session Status.



Settings Document

A special file that stores information required to connect to a specific FirstClass® system.



Setup button

Click this button to change your settings. These settings include information required to connect to the 
server, including (optionally) your user id and password. Once you’ve entered the settings correctly, you 
shouldn't need to change them. If you need help with these settings contact your FirstClass Administrator.



Size

Size of the message in kilobytes, including any attachments.



Sounds

Check this box to hear sounds when new chat messages are delivered and when a user enters or leaves 
the chat.



Special forms

Messages can be written on forms containing special fields or customized graphics. Your system comes 
with several useful forms, including one for taking telephone messages and another for sending 
requisitions. To create a new message with one of these forms, choose Message ® New Form.



Splash screen

A screen containing information about the FirstClass system to which you are connecting.



Split bar

The split bar divides the window into two panes. In a file list window, the upper pane contains folders and 
conferences and the lower pane contains messages and files. In a message window, the upper pane 
contains the envelope and the lower pane contains the message body. To move the split bar, place the 

mouse over the bar and drag after the cursor changes to a cross, like this:    



Status lines

The lines on the Login form that display connection progress. The first line shows the action in progress. 
For modem connections, the second line shows the commands sent to the modem and the responses 
from the modem.

If you have any problems logging in, contact your FirstClass Administrator.



Subject

The subject of the message. For an external folder, this field is blank.



Subject

Enter the subject of the message here. If the message is a reply, the subject is entered for you 
automatically and prefaced by Re:. (Re: Graphics Animator 1.0, for example.) You can change this 
subject.



Subscription

The ability to access a conference.



Title

The name of the conference or folder. The name also appears in the View menu.



Title

The subject of the message.



To

Enter the destination of the message here. For more information, see Addressing a message.



Transferring files

FirstClass allows you to share files with other users by attaching them to e-mail messages.

Note: To send and receive attachments you must have been assigned the necessary privileges by your 
FirstClass Administrator.

Previewing attachments

Saving attachments

Attaching files to messages



Unlisted user

Only users who have the right to view unlisted users can send mail to unlisted users or view their names 
in the FirstClass Directory.



Unread Flag

An unread flag     appears beside your mailbox or a conference if they contain any items that you have 
not read. Note: You can turn the flag off by holding the Control key and clicking on the flag. The flag is 
removed from every message in the mailbox or conference.



Unread Flag

An unread flag appears beside each item that you have not yet read.



Uploading

Copying files from the client to the server.



User ID and Password

You must have a user id and password to connect to a FirstClass system. Contact your FirstClass 
Administrator for details. On some systems you can auto-register and set up your own user id. If you don't 
want to enter your user id every time you log on, you can save it in your Settings Document. To do so, 
click Setup.



The View menu

The View menu contains the following commands:

By Icon

Displays entries in the current window pane using icons.

By Date

Displays entries in the current window pane as a list sorted in date order, with the oldest item at the top.

By Name

Displays entries in the current window pane as a list sorted in alphabetical order by sender’s name.

By Subject

Displays entries in the current window pane as a list sorted in alphabetical order by subject.

By Size

Displays entries in the current window pane as a list sorted in order of increasing size.

By Status

Displays entries in the current window pane as a list sorted by status, as follows: Outgoing messages are 
displayed first, sorted first into normal and urgent messages, and then by date. Incoming messages are 
displayed last, also sorted into normal and urgent messages, and then by date.

Reverse Sort

Reverses the currently selected sort order. Lists sorted by date are displayed with the latest message 
first; lists sorted alphabetically are displayed in reverse alphabetical order (starting with “z”); lists sorted by 
size will be displayed with the largest item first; and lists sorted by status will be displayed with the newest 
urgent messages at the top.

Clean Up Icons

Arranges the selected icons on a grid in the current window.



Window summary

The part of the window that displays the name and type of the window as well as the number of files and 
folders in the window.



Window type

A file list can be a conference, a mailbox, or a folder.



The Window menu

The Window menu contains the following commands:

Tile

Makes all open windows the same size and tiles them on the available screen.

Cascade

Stacks all windows so that their title bars are visible, beginning in the upper-left corner of the screen.

Arrange Icons

Arranges all icons in the current window on a grid.

Smart Zoom

Expands the current window to uncover all icons.

Session Status

Displays the session status window.

Palette

Displays the palette.

Desktop

Makes the FirstClass DeskTop window the active window and brings it to the front.



Working with file lists

You will find that you spend most of your time in FirstClass working with file lists—either your mailbox, a 
conference, or an external folder. You can perform the following operations on items in a file list:

Create new messages

Delete messages

File messages in folders

Forward a message

Reply to a message

Display the next and previous unread message

Display the next and previous message in the thread

Display message history

Make an alias

Note: Many of these operations are accessible from the palette.

Create new messages    

To create a new message, choose Message ® New Message or Message ® New Form. (Note: If you are 
in a conference, the message is automatically addressed to the conference.) A copy of the message is 
stored in your mailbox. 

Delete messages    

You can delete messages in your mailbox as well as any conference items that you have sent. To delete 
an item, select it and choose File ® Delete. You can select multiple items for deletion by holding down the 
Shift key while you click on them. Note: If the Delete option is dimmed, you cannot delete the selected 
item. 

File messages in folders

Within your mailbox, you can create folders to file your messages. To create a folder, choose Conference 
® New Folder. To rename the folder or give it a custom icon, select it and choose File ® Get Info. You can 
now drag messages into the folder.

Forward a message      

To forward a message, select or open the message and choose Message ® Forward. FirstClass creates 
a copy of the message (including any attachments). You can address and edit the copy and add 
additional attachments. To find out who has forwarded a message, display the message history.

Reply to a message    

To reply to a message, select or open the message and choose Message ® Reply. FirstClass creates a 
new message with the To, Cc, and Subject lists filled in. (If you reply to a message in your mailbox, the 



reply is automatically addressed to the person who sent the original message. If you reply to an item in a 
conference, the reply is automatically addressed to the conference. To select different reply recipients, 
use the Reply Special command.). Click in the lower pane and type your message.

Display the next and previous unread message      

When you log into FirstClass, you generally want to read your unread messages right away. You can 
quickly open unread items by choosing Conference ® Open Unread. If you have no more unread items 
FirstClass beeps.

Display the next and previous message in the thread      

If a message in your mailbox or in a conference is part of a thread , you can browse through the rest of 
the thread by choosing Conference ® Next in Thread. 

Display message history    

To view the history of a message, select or open the message and choose Message ® History. The 
History window opens. It contains a record of everything that has happened to the message, including 
when (and by whom) it was created and when (and by whom) it has been read. If the message has any 
attachments, the history also indicates who has downloaded them.

Make an alias

If there is a particular conference you are interested in, you can place an alias of it on your desktop. To do 
so, select the conference icon and choose Conference ® Make Alias. You can then reposition the alias on 
your desktop for maximum convenience.

Addressing a message



Working with résumés

A résumé is a description of a user or conference. In addition, a résumé can have an optional picture in 
the upper left corner of the window.

Displaying and viewing a résumé

Editing a résumé

Displaying and viewing a résumé
Double-clicking on a name in a To, Cc, or From list; in a directory window; in a chat; or in a history window 
displays the résumé for that user. Each user and every conference can have a résumé.

Editing a résumé
To edit your résumé, choose Edit ® Résumé.

The résumé consists of three parts:

A field at the left of the top pane of the form, into which you can paste a picture.

A title field at the right of the top pane of the form, into which you can enter your name.

The bottom pane of the form, which you can edit in the same way as a message.

The changes you make are saved when you close the résumé window.



Alias

A copy of a conference icon that has been placed on your desktop, so that you can open the conference 
directly from the desktop. If you have an alias of a conference on your desktop, you can tell as soon as 
you log in whether the conference contains unread items. To create an alias, select the conference and 
choose Conference ® Make Alias.



Thread

An original message and the set of replies to that message. Each conference can contain multiple 
threads.






